Integration of a SITOP 24 V Power Supply in SIMATIC PCS 7

SITOP PSU8200, PSE202U, PSE200U, UPS1600, PSU8600

Warranty and Liability

Note

The Application Examples are not binding and do not claim to be complete regarding the circuits shown, equipping and any eventualty. The Application Examples do not represent customer-specific solutions. They are only intended to provide support for typical applications. You are responsible for ensuring that the described products are used correctly. These Application Examples do not relieve you of the responsibility to use safe practices in application, installation, operation and maintenance. When using these Application Examples, you recognize that we cannot be made liable for any damage/claims beyond the liability clause described. We reserve the right to make changes to these Application Examples at any time without prior notice.

If there are any deviations between the recommendations provided in these Application Examples and other Siemens publications – e.g. Catalogs – the contents of the other documents have priority.

We do not accept any liability for the information contained in this document. Any claims against us – based on whatever legal reason – resulting from the use of the examples, information, programs, engineering and performance data etc., described in this Application Example shall be excluded. Such an exclusion shall not apply in the case of mandatory liability, e.g. under the German Product Liability Act ("Produkthaftungsgesetz"), in case of intent, gross negligence, or injury of life, body or health, guarantee for the quality of a product, fraudulent concealment of a deficiency or breach of a condition which goes to the root of the contract ("wesentliche Vertragspflichten"). The damages for a breach of a substantial contractual obligation are, however, limited to the foreseeable damage, typical for the type of contract, except in the event of intent or gross negligence or injury to life, body or health. The above provisions do not imply a change of the burden of proof to your detriment.

Any form of duplication or distribution of these Application Examples or excerpts hereof is prohibited without the expressed consent of the Siemens AG.

Security information

Siemens provides products and solutions with industrial security functions that support the secure operation of plants, systems, machines, and networks. In order to protect plants, systems, machines and networks against cyber threats, it is necessary to implement – and continuously maintain – a holistic, state-of-the-art industrial security concept. Siemens' products and solutions only form one element of such a concept.

Customer is responsible for preventing unauthorized access to their plants, systems, machines, and networks. Systems, machines, and components should only be connected to the enterprise network or the Internet if and to the extent necessary and with appropriate security measures in place (e.g. use of firewalls and network segmentation).

Additionally, Siemens' guidance on appropriate security measures should be taken into account. For more information about industrial security, please visit http://www.siemens.com/industrialsecurity.

Siemens' products and solutions undergo continuous development to make them more secure. Siemens strongly recommends applying product updates as soon as they are available and to always use the latest product versions. Use of product versions that are no longer supported and failure to apply the latest updates may increase customer’s exposure to cyber threats.

To stay informed about product updates, subscribe to the Siemens Industrial Security RSS feed at http://www.siemens.com/industrialsecurity.
# Table of contents

Warranty and Liability .............................................................................................................. 2

1 Task ...................................................................................................................................... 5

2 The solution ........................................................................................................................... 6
   2.1 Overview ........................................................................................................................... 6
   2.2 Hardware and software components ............................................................................... 8

3 Basics ................................................................................................................................... 9
   3.1 SITOP PSU8200 .............................................................................................................. 9
   3.2 SITOP PSE202U ........................................................................................................... 10
   3.3 SITOP UPS1600 with UPS1100 .................................................................................... 11
   3.4 SITOP PSE200U ........................................................................................................... 12
   3.5 Power supply system SITOP PSU8600 .......................................................................... 13

4 Redundant 24 V DC power supply ....................................................................................... 14
   4.1 Configuring the hardware configuration ........................................................................ 15
   4.2 Copying process tag types ............................................................................................ 16
   4.3 Creating an AS program .............................................................................................. 17
   4.4 Parameterizing messages ............................................................................................. 19
   4.5 Creating a process picture ............................................................................................ 20
   4.6 Runtime ......................................................................................................................... 21

5 Uninterruptible 24 V power supply ...................................................................................... 22
   5.1 UPS1600 on the PROFINET IO fieldbus ..................................................................... 22
   5.1.1 Configuring the hardware configuration .................................................................. 23
   5.1.2 Copying process tag types ....................................................................................... 28
   5.1.3 Creating an AS program ......................................................................................... 29
   5.1.4 Messages ................................................................................................................ 30
   5.2 UPS1600 with monitoring of the signal contacts ......................................................... 31
   5.2.1 Configuring the hardware configuration .................................................................. 32
   5.2.2 Copying process tag types ....................................................................................... 32
   5.2.3 Creating an AS program ......................................................................................... 33
   5.2.4 Parameterizing messages ......................................................................................... 36
   5.3 Creating a process picture ............................................................................................ 37
   5.4 Runtime ......................................................................................................................... 38

6 Selective monitoring of 24 V feeders ................................................................................. 39
   6.1 Configuring the hardware configuration ....................................................................... 40
   6.2 Copying process tag types ............................................................................................ 41
   6.3 Creating an AS program .............................................................................................. 42
   6.4 Parameterizing a message ............................................................................................ 44
   6.5 Creating a process picture ............................................................................................ 45
   6.6 Runtime ......................................................................................................................... 46

7 Power supply system SITOP PSU8600 ............................................................................. 47
   7.1 Hardware configuration ................................................................................................. 48
   7.2 Copying process tag types ........................................................................................... 53
   7.3 Creating an AS program .............................................................................................. 54
   7.4 Messages ....................................................................................................................... 55
   7.5 Creating a process picture ............................................................................................ 56
   7.6 Runtime ......................................................................................................................... 57

8 Commissioning the demo project ....................................................................................... 58
   8.1 Installation ....................................................................................................................... 58
   8.2 Operating SITOP modular ........................................................................................... 60
Table of contents

8.2.1 Overview of the power supply ......................................................... 60
8.2.2 Monitoring of redundancy ............................................................... 61
8.2.3 Monitoring of the DC UPS ............................................................... 62
8.2.4 Monitoring the selectivity module ................................................... 66
8.3 Operating the PSU8600 power supply system ..................................... 67

9 References .............................................................................................. 70

10 History .................................................................................................... 70
1 Task

Introduction

The reliable 24V power supply is an important factor in high plant availability during the operation of SIMATIC PCS 7. SITOP makes available 1- or 3-phase basic power supply units with different output power ratings of up to 1000 W. These units have comprehensive certifications like ATEX or IECex as well as MTBF values of up to 1 million hours in 24-hour uninterrupted duty.

Depending on the requirements and plant configuration, they can be extended on a scalable basis. In the present application example, we will go into the details of the following configurations:

- Redundant 24 V DC power supply
- Buffered 24 V power supply with battery storage
- Selective monitoring of individual 24 V feeders
- Power supply system SITOP PSU8600

Other 24 V supply concepts are described in Chapter 18 of the manual entitled SIMATIC PCS 7 Standard Architectures.

Description of the automation task

It is intended to implement a 24V power supply from the SITOP range in a PCS 7 system for the automation technology and the external peripherals. If possible, the power supply must be designed on a failsafe basis. The system operating personnel must be able to monitor the status of the 24V power supply on the PCS 7-Operator Station.

Fig. 1-1
2 The solution

2.1 Overview

The 24 V power supply of the PCS 7 automation technology is implemented using SITOP modular power supply units and the associated expansion modules or using the SITOP PSU8600 power supply system.

The application example shows how to configure the hardware in the SIMATIC Manager and to easily integrate it into the PCS 7 control system. Default blocks from the PCS 7 Advanced Process Library and product-specific blocks are used for the AS program.

You can download the library containing the pre-configured process tag types and the product-specific blocks for SITOP UPS1600 and SITOP PSU8600 in the item entitled SITOP Library for SIMATIC PCS 7.

The enclosed demo project gives you a comprehensive overview of configuration and the way of functioning.

SITOP modular

This variant uses SITOP PSU8200 power supply units, the SITOP PSE202U redundancy module, the SITOP UPS1600/UPS1100 uninterruptible power supply with battery module, and the SITOP PSE200U selectivity module.

Fig. 2-1
Power supply system SITOP PSU8600

Another variant uses the SITOP PSU8600 power supply system. The basic unit with four outputs that are selectively monitored is expanded by four more outputs (CNX8600) that are selectively monitored. Using the (BUF8600) buffer module, it is possible to bypass brownouts.

Fig. 2-2
2.2 Hardware and software components

The application has been created with the following components:

**Hardware components**

Table 2-1

<table>
<thead>
<tr>
<th>Component</th>
<th>Qty.</th>
<th>Article number</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>AS 410-5H</td>
<td>1</td>
<td>6ES7 410-5HX08 0AB0</td>
<td>Automation system</td>
</tr>
<tr>
<td>ET 200SP+HF</td>
<td>1</td>
<td>6ES7 155-GAU00-0CN0</td>
<td>External peripherals</td>
</tr>
<tr>
<td>PSU8200</td>
<td>2</td>
<td>6EP3 334-8SB00-0AY0</td>
<td>DC 24 V/10 A power supply</td>
</tr>
<tr>
<td>PSE202U</td>
<td>1</td>
<td>6EP1 961-3BA21</td>
<td>Redundancy module</td>
</tr>
<tr>
<td>UPS1600</td>
<td>1</td>
<td>6EP4 134-3AB00-2AY0</td>
<td>DC 24 V/10 A DC UPS</td>
</tr>
<tr>
<td>UPS1100</td>
<td>1</td>
<td>6EP4131-0GB00-0AY0</td>
<td>Battery module, 1.2 Ah</td>
</tr>
<tr>
<td>PSE200U</td>
<td>1</td>
<td>6EP1 961-2BA11</td>
<td>Selectivity module, 4x 3 A</td>
</tr>
<tr>
<td>PSU8600</td>
<td>1</td>
<td>6EP3437-8MB00-2CY0</td>
<td>Power supply system DC 24 V/4x 10 A</td>
</tr>
<tr>
<td>CNX8600</td>
<td>1</td>
<td>6EP4437-8XB00-0CY0</td>
<td>Expansion module, 4x 10 A</td>
</tr>
<tr>
<td>BUF8600</td>
<td>1</td>
<td>6EP4297-8HB10-0XY0</td>
<td>Buffer module, 300 ms/40 A</td>
</tr>
</tbody>
</table>

**Software components**

Table 2-2

<table>
<thead>
<tr>
<th>Component</th>
<th>Qty.</th>
<th>Article number</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIMATIC PCS 7 V8.1</td>
<td>1</td>
<td>6ES7651-5AA18-0YA0</td>
<td>Standard engineering software</td>
</tr>
<tr>
<td>SITOP Library</td>
<td>1</td>
<td></td>
<td>Module library for SITOP Download</td>
</tr>
<tr>
<td>UPS1600 GSD</td>
<td>1</td>
<td></td>
<td>Download</td>
</tr>
<tr>
<td>PSU8600 GSD</td>
<td>1</td>
<td></td>
<td>Download</td>
</tr>
</tbody>
</table>

**Example files and projects**

Table 2-3

<table>
<thead>
<tr>
<th>Component</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>109481908_PCS7_SITOP24V_Demo_V10.zip</td>
<td>This archive contains the PCS 7 demo project</td>
</tr>
<tr>
<td>109481908_PCS7_SITOP24V_Docu_V10_en.pdf</td>
<td>This document</td>
</tr>
</tbody>
</table>
3 Basics

3.1 SITOP PSU8200

One- and three-phase SITOP PSU8200 devices are the technology power supplies for demanding solutions. The wide-range input makes it possible to connect to almost any electrical power system worldwide and ensures a high degree of safety even when large voltage fluctuations occur. They offer outstanding overload characteristics: Power boost delivers up to three-times the rated current for short periods of time, and with extra power of 150%, loads with high power consumption can be connected without any problems. The very high degree of effectivity keeps energy consumption and heat dissipation in the control cabinet very low and the compact metal housing also saves space.

You can find detailed information here: SITOP modular

Fig. 3-1
3.2 SITOP PSE202U

SITOP redundancy modules provide additional protection from failure of the 24 V supply. The redundancy module continuously monitors two identical power supply units. If one unit fails, the other one automatically supplies the power. Additionally, a signal is sent via a signal contact that can be evaluated by a controller, PC, or control system.

You can find detailed information here: SITOP redundancy modules

Fig. 3-2
3.3 SITOP UPS1600 with UPS1100

In the case of a power failure, the SITOP UPS1600 uninterruptible power supply can supply the automation system with 24V for up to several hours. Depending on the version of the DC UPS, it is integrated into the control system by means of digital I/Os or via PROFINET (Figure 3-3). The intelligent battery management of the UPS1600 ensures optimum charging and continuous monitoring of the UPS1100 battery modules. The buffer time of the DC UPS depends on the load current and capacity and the number of battery modules. When choosing the correct DC UPS configuration, the SITOP Selection Tool helps you in an optimum way.

You can find detailed information here: SITOP DC UPS with battery modules

Fig. 3-3

You can find more information about using PROFINET here: SIMATIC PCS 7 with PROFINET
3.4 SITOP PSE200U

The selectivity and diagnostics modules are the optimum enhancement for all 24V power supplies to distribute the load current to several feeders and to monitor it. The module detects an overload or short-circuit in one or more feeders and shuts them down as needed. This is ensured even on high-resistance lines and in the case of "creeping" short-circuits. The intact feeders continue to supply the SITOP selectivity modules with 24 V on an absolutely interruption- and reaction-free basis. Their signal contact can be looped across several selectivity modules and can be evaluated as a common alarm in SIMATIC PCS 7.

You can find detailed information here: SITOP selectivity modules

Fig. 3-4
3.5 Power supply system SITOP PSU8600

The SITOP PSU8600 power supply system consists of a PSU8600 basic unit, up to three CNX8600 expansion modules, and a maximum of two BUF8600 buffer modules. The three-phase basic unit provides either one selectively monitored output or four selectively monitored outputs (Figure 3-5). Using the power boost of 150 %, loads with high power consumption can be connected without any problems. The modular system with the innovative System Clip Link connection system allows for an individual combination of the power supply system without needing additional wiring. The order of the expansion modules and buffer modules is irrelevant in this case. The power supply is monitored by means of the integrated Ethernet/PROFINET interface or, as an alternative, using the digital signal contacts. You can find detailed information here: Power supply system SITOP PSU8600

Fig. 3-5

You can find more information about using PROFINET here: SIMATIC PCS 7 with PROFINET
4 Redundant 24 V DC power supply

For redundant power supply, you need two identical (PSU8200) power supply units and one (PSE202U) redundancy module. Ideally, you should connect both power supply units to separate 120/230V electric circuits. To monitor redundancy, the signal contact of the redundancy module is connected to one of the digital inputs of the external peripherals. The signal contact is executed as a changeover switch, which means that it can signal the “good” and “bad” states. Apart from this, it is possible to connect the power supply units to the external peripherals. The signal contact of the power supply units is executed as a normally open contact and it signals the “good” state.

Fig. 4-1
4.1 Configuring the hardware configuration

You do not configure the hardware of the power supply and the of the redundancy module in the SIMATIC Manager. You configure the AS and the external peripherals according to the PCS 7 standard. To monitor the power supply units and the redundancy module, the signal contacts are each connected to one of the digital inputs of the external peripherals and symbolized appropriately in the hardware configuration.

The procedure is as follows:
1. In SIMATIC Manager, open the hardware configuration of the automation system.
2. Highlight the digital input assembly of the external peripherals (1) and choose menu command “Edit > Symbols…”.
3. Enter an appropriate symbolic name (2) for the inputs that are connected to the power supply units and the redundancy module.
4. Click on “OK” to confirm your changes.
5. Compile and load the changed hardware configuration.

Fig. 4-2
4.2 Copying process tag types

Before starting to create the AS program, it is advisable to copy the necessary plan templates to the master data library of the PCS 7 project. Process tag type “PSU2ModulesRed” is available for the redundant power supply. This process tag type contains the three “Pcs7DiIn” driver blocks and three “MonDiL” monitoring blocks that have already been interconnected correctly.

The procedure is as follows:

1. Open the SITOP library.
2. Copy process tag type “PSU2ModulesRed” (1) to the “Process tag types” folder in the master data library.
3. Make sure that you copy the APL blocks that are used to the master data library too. To do this, create a CFC plan (2) by copying blocks “Pcs7DiIn” and “MonDiL” from the PCS 7 APL.

Fig. 4-3
4.3 Creating an AS program

The procedure is as follows:

1. Drag and drop process tag type “PSU2ModulesRed” to the desired folder in the technological hierarchy and rename it (1).

2. Open the plan and adapt each input signal as follows:
   - Rename the monitoring blocks to match their uses (2).
   - Interconnect inputs “PV_In” with the corresponding symbols of the external peripherals (3).
   - Invert the “In” input signals (4) on the monitoring blocks of the power supply units, since their signal contact is closed in the “good” state.
   - At the “Color” inputs of the monitoring blocks (5), parameterize the value “16#1”. This is so that the system displays the value in red in the faceplates in accordance with an alarm.
3. Compile the AS program and update the view of the CFC plan.
4. Load the program into the automation system.
4.4 Parameterizing messages

To allow operators to assign the message if one of the devices fails, they are adapted on the monitoring blocks.

The procedure is as follows:

1. Open one after the other the properties of the "MonDiL" blocks and click on the "Messages..." pushbutton.
2. In the message configuration dialog, change the message text (1). However, leave the "$BlockComment$$" system instruction in the message text.
3. Click on the "Save" pushbutton (2) to confirm your change.
4. Close the properties of the monitoring block.

Note

If you need message texts in several languages, you use the menu command Tools > Manage multilingual texts > Change language... in the SIMATIC Manager to change the language for display texts and adapt the text in the message configuration for the set language.
You need a process picture to visualize the status of the redundant power supply. The procedure is as follows:

1. Create a new process picture or open an existing one (1) in the folder of the technological hierarchy in which the CFC plan that you edited before is located.

2. Execute the Compile OS function so that the system creates the process variables and the messages in the OS project as well as the block icons in the process picture.

3. Open the process picture using the WinCC Graphics Designer.

4. Draw the process picture as you want it to appear and position the block icons (2) at the intended location in the picture.

5. Save the adapted process picture and close it.
4 Redundant 24 V DC power supply

Note
In the example, small squares are configured as LED lamps to represent the status of the assemblies in color in addition to the block icons. With the squares, the background color is dynamized and linked to the process values of the monitoring blocks.

- OUT#Value = 0 -> green
- OUT#Value = 1 -> red

4.6 Runtime

After starting runtime and switching to the corresponding technological hierarchy, it is now possible to monitor the status of the redundant power supply on the OS. Apart from this, the system issues a message if the threshold voltage is fallen short of or one of the power supplies fails.

Fig. 4-9
5 Uninterruptible 24 V power supply

To buffer the power supply, you need a (UPS1600) DC UPS module and a (UPS1100) battery module in addition to the power supply units. Battery modules are available with a choice of capacities ranging from 1.2 Ah to 12 Ah. You can also use several battery modules of the same type to achieve higher capacities. The intelligent battery management of the UPS1600 automatically detects the connected UPS1100 battery modules and ensures optimum temperature-specific charging.

The DC UPS module can be monitored in different ways:
- Monitoring via Industrial Ethernet on the plant bus
- Monitoring the signal contacts via the external peripherals

Below, we will describe configuration of both options in the SIMATIC Manager. There is no difference between OS configuration of both variants.

5.1 UPS1600 on the PROFINET IO fieldbus

You can parameterize the DC UPS module in the SIMATIC Manager using the Generic Station Description. Monitoring of the DC UPS on the OS is carried out using product-specific function blocks that you can download for free from the item entitled “SITOP Library for SIMATIC PCS 7”.

Fig. 5-1
5 Uninterruptible 24 V power supply

5.1.1 Configuring the hardware configuration

You configure the AS and the external peripherals according to the PCS 7 standard. To configure the SITOP UPS1600 uninterruptible power supply, the corresponding GSD file must be installed.

You can find the Generic Station Description in the item entitled GSD for SITOP UPS1600 for integration in STEP 7 V5.

Parameterizing Ethernet nodes

The SITOP UPS1600 communicates by means of PROFINET IO on the automation system’s fieldbus. If you have not already done so, you must first adapt the IP address and the device name of the UPS to the network configuration of the fieldbus.

Note

To parameterize the Ethernet nodes, they must be on the same physical network as the ES. After this, you can make the separation between the plant bus and the process bus (field level).

The procedure is as follows:

1. Make sure that the device is on the same physical network as the ES.
2. In the SIMATIC Manager, execute the menu command “Target system > Edit Ethernet Node”.
3. In the “Edit Ethernet Node” dialog, click on the “Browse” pushbutton (1) in the “Ethernet Node” area.
4. In the “Browse Network” dialog, choose the UPS1600 from the list of nodes and click on “OK” to confirm your selection.
5. Edit the IP address to match your network configuration and click on the “Assign IP Configuration” pushbutton (2).
6. Edit the device name and click on the “Assign Name” pushbutton (3).
7. Close the dialog again.
5 Uninterruptible 24 V power supply

Fig. 5-2

Edit Ethernet Node

- Ethernet node
  - MAC address: 70:3F:07:76:76:67

- Set IP configuration
  - Use IP parameters
    - IP address: 192.168.72.10
    - Subnet mask: 255.255.255.0
  - Gateway
    - Do not use router

- Obtain IP address from a DHCP server
  - Identified by
    - Client ID
      - Client ID:
  - Assign IP Configuration

- Assign device name
  - Device name: de-up:10a

- Reset to factory settings

© Siemens AG 2016 All rights reserved
5 Uninterruptible 24 V power supply

Configuring the hardware

The next thing to do is to update the UPS1600 in the hardware configuration. The procedure is as follows:

1. Drag the UPS1600 from the device catalog (1) onto the PROFINET IO system of the AS.
2. Open the properties of the DC UPS and enter the device name (2) and the device's IP address (3).

Fig. 5-3

Setting the SITOP UPS1600 parameters

You can set the hardware parameters of the UPS1600 in the HW configuration too. You can find more detailed information on the different parameters in the manual entitled SITOP UPS1600 / UPS1100.
The procedure is as follows:

1. Select the DC UPS (1) in the hardware configuration.
2. Open the properties of the “UPS1600 xxA PN” modules (2) on slot 0.1 by double-clicking.
3. Switch to the “Parameters” tab.
4. Set the parameters (3) as required here.
5. Compile and load the hardware configuration.

Note

Note that remote parameterization by means of the HW configuration is only effective if you have set the “V THR (V)” selector switch (1) on the device to the “REN” position.
Configuring symbols

To interconnect the driver block of the control program with a symbolic address at a later time, parameterize the I/O addresses of the DC UPS using symbols.

The procedure is as follows:

1. Select the DC UPS (1) in the hardware configuration.
2. Highlight module “UPS1600 xxA PN” (2) on slot 0.2 and execute menu command “Edit > Symbols…”.
3. Click on the “Add to Symbols” pushbutton. This automatically adds the standard address symbols.
4. Compile and load the hardware configuration.

Fig. 5-5
5 Uninterruptible 24 V power supply

5.1.2 Copying process tag types

The function blocks of the SITOP UPS1600 are configured in process tag type “UPS1600”. This type contains one “DrvUPS” driver block and the “UPS1600” monitoring block. The blocks have already been correctly interconnected with one another.

The procedure is as follows:

1. Open the SITOP library.
2. Copy process tag type “UPS1600” (1) to the “Process tag types” folder in the master data library.

Fig. 5-6

The figure shows the process tag type “UPS1600” configured in the SITOP library, with the “DrvUPS” driver block and the “UPS1600” monitoring block correctly interconnected.
5 Uninterruptible 24 V power supply

5.1.3 Creating an AS program

The procedure is as follows:

1. Drag process tag type “UPS1600” to the desired folder in the technological hierarchy and rename it. (1)

Fig. 5-7

2. Open the plan and carry out the following modifications:
   - Interconnect input “PV_In” to the first input address of the UPS1600. If you have used the standard symbols, the symbol is called “IBxxx_Input voltage” (2).
   - Rename the monitoring block to match its use (3).

Fig. 5-8

3. Compile the AS program and update the view of the CFC plan.
4. Load the program into the automation system.
5.1.4 **Messages**

The messages of the SITOP UPS1600 have already been parameterized in the function block and you do not need to change them.

Fig. 5-9
5.2 UPS1600 with monitoring of the signal contacts

The DC UPS is monitored using the external peripherals. To do this, the signal contacts of the module are connected to the digital inputs of the external peripherals.

The UPS1600 makes available the following three signal contacts for signaling the status:

- Relay 1: Buffering mode or OFF (changeover switch)
- Relay 2: Buffer not ready, rechargeable battery defective (changeover switch) (The system displays a defective rechargeable battery by the changeover switch changing its position in a 0.25 Hz cycle.)
- Relay 3: Rechargeable battery charge > 85% (normally open contact)

The following figure shows the selected wiring on the signal terminal:
5.2.1 Configuring the hardware configuration

You do not configure the hardware of the uninterruptible power supply in the SIMATIC Manager. You configure the AS and the external peripherals according to the PCS 7 standard. The digital inputs of the external peripherals that are connected to the DC UPS are shown in the HW configuration using appropriate symbols.

The procedure is as follows:
1. In SIMATIC Manager, open the hardware configuration of the automation system.
2. Highlight the digital input assembly of the external peripherals (1) and choose menu command “Edit > Symbols…”.
3. At the inputs that are connected to the DC UPS, enter an appropriate symbolic name (2).
4. Click on “OK” to confirm your changes.
5. Compile and load the changed hardware configuration.

Fig. 5-12

5.2.2 Copying process tag types

Before starting to create the AS program, it is advisable to copy the necessary plan templates to the master data library of the PCS 7 project. In the example we use process tag type “SITOP” with the APL blocks to monitor a digital signal.
The procedure is as follows:

1. Open the SITOP library.
2. Copy process tag type “SITOP” (1) to the “Process tag types” folder in the master data library.
3. Make sure that you copy the APL blocks that are used to the master data library too. To do this, create a CFC plan (2) by copying blocks “Pcs7DiIn” and “MonDiL” from the PCS 7 APL.

Fig. 5-13

5.2.3 Creating an AS program

The procedure is as follows:

1. Drag process tag type “SITOP” to the desired folder in the technological hierarchy and rename it. (1)

Fig. 5-14
2. Open the plan and carry out the modifications below for the input signal to monitor buffering mode (Rel. 1):
   - Rename the monitoring block (2) to match its use. Here, the system monitors the signal for buffering mode.
   - Interconnect input “PV_In” with the corresponding symbol of the external peripherals (3).
   - At the “Color” input (4) of the monitoring block, parameterize the value “16#2”. This is so that the system displays the value in yellow in the faceplate in accordance with a warning.

Fig. 5-15

3. Copy interconnected blocks “Pcs7DiIn” and “MonDiL” to the clipboard and paste them into the CFC plan again. Carry out the modifications below for monitoring the battery status (Rel. 2):
   - Rename the monitoring block (5) to match its use. Here, the system monitors the “Buffer not ready” and “Rechargeable battery fault” signals.
   - Interconnect input “PV_In” with the corresponding symbol of the external peripherals (6).
   - Change the value at input “FlutTmIn” (7) to 5 seconds. This makes it possible for the block to detect signal flutter\(^1\). In the example, this property is used to collect the 0.25 Hz signal for a defective battery.

\[^1\] If the input signal state changes in the specified time and the set number of “FlutFact” changes from 0 to 1, the system sets output “FlutAct” and outputs an appropriate message. Detection of signal flutter “FlutEN” and triggering of a message are activated as standard.

   - At the “Color” input (8) of the monitoring block, parameterize the value “16#1”. This is so that the system displays the value in red in the faceplate in accordance with an alarm.
4. Copy interconnected blocks “Pcs7DiIn” and “MonDiL” to the clipboard again and paste them into the CFC plan again. Carry out the modifications below for monitoring the battery charge (Rel. 3):
   - Rename the monitoring block (9) to match its use. Here, the system monitors the “Battery charge > 85%” signal.
   - Interconnect input “PV_In” with the corresponding symbol of the external peripherals (10).
   - At parameters “FlutTmIn = 0.0” and “Color = 16#0”, you use the default values.

5. Compile the AS program and update the view of the CFC plan.
6. Load the program into the automation system.
5.2.4 Parameterizing messages

Open the message configurations of the “MonDiL” blocks one after the other and carry out the following modifications:

1. At “SIG1” of buffer monitoring (1), change the message text and the message class to “Warning – high”.
2. At “SIG1” and “SIG2” of battery monitoring (2), change the message text and the message class to “Warning – high”.
3. At “SIG1” of status monitoring (3), change the message text and the message class to “Process Message – With Acknowledgement”.

Note

If you need message texts in several languages, you use the menu command Tools > Manage multilingual texts > Change language… in the SIMATIC Manager to change the language for display texts and adapt the text in the message configuration for the set language.
5.3 Creating a process picture

Installing the SITOP library for PCS 7 also copied the block icons and faceplates for display on the OS. Depending on the variant that you used to monitor the DC UPS, the “Compile OS” function generates the corresponding block icons in the process picture. In this example, both variants were configured.

The procedure is as follows:

1. Create a new process picture or open an existing one (1) in the folder of the technological hierarchy in which the CFC plan that you edited before is located.

2. Execute the Compile OS function so that the system creates the process variables, the messages, and the block icon in the OS project.

3. Open the process picture using the WinCC Graphics Designer.

4. Draw the process picture as you want it to appear and position the block icon of the PROFINET variant (2) or the APL symbols of the status signal variant (3) at the intended location in the picture.

5. Save the adapted process picture and close it.

Fig. 5-19

Fig. 5-20
5.4 **Runtime**

After starting runtime and switching to the corresponding technological hierarchy, it is now possible to monitor the status of the uninterruptible power supply on the OS. The block icon (1) shows the current charge of the battery and indicates pending messages. In the faceplate (2), you get detailed information about the operating status of the DC UPS and you can view and acknowledge the messages on a process tag-specific basis.

On the faceplate, you can choose between the following views:

- Standard view
- Messages
- Trends
- Notes
- Batch view

![Fig. 5-21](image-url)
6 Selective monitoring of 24V feeders

Using the SITOP PSE200U selectivity module, you can monitor up to four 24 V feeders and switch them off individually in the case of a fault. Different versions of the selectivity module are available each of which has an output current range of 0.5...3 A or 3...10 A.

In the example, we used a module with a common alarm. The signal contact is executed as a changeover switch, which means that it can signal the “good” and “bad” states. Apart from this, remote resetting is possible from a central location.

Fig. 6-1
6.1 Configuring the hardware configuration

You do not configure the hardware of the power supply and of the selectivity module in the SIMATIC Manager. You configure the AS and the external peripherals according to the PCS 7 standard. To monitor the selectivity module, the signal contact is connected to one of the digital inputs of the external peripherals and symbolized appropriately in the hardware configuration. To reset a fault, the remote reset contact is connected to one of the digital outputs of the external peripherals and symbolized appropriately in the hardware configuration.

The procedure is as follows:

1. In SIMATIC Manager, open the hardware configuration of the automation system.
2. Highlight the digital input assembly of the external peripherals (1) and choose menu command “Edit > Symbols…”.
3. At the input that is connected to the selectivity module, enter an appropriate symbolic name (2).
4. Click on “OK” to confirm your changes.
5. Highlight the digital output assembly of the external peripherals (3) and choose menu command “Edit > Symbols…”.
6. At the output that is connected to the reset switch of the selectivity module, enter an appropriate symbolic name (4).
7. Click on “OK” to confirm your changes.
8. Compile and load the changed hardware configuration.

Fig. 6-2
6.2 Copying process tag types

Before starting to create the AS program, it is advisable to copy the necessary plan templates to the master data library of the PCS 7 project.

Process tag type "PSE200U" is available for a selectivity module with single-channel signaling. This tag type contains the "Pcs7DiIn" driver block and a "MonDiL" monitoring block for each channel. The configured "PSE_DIAG" block (FB50) processes the output signal of the module.

In the present example, we used a selectivity module with a common signaling contact. You can use the "SITOP" process tag type for this module. This tag type contains the APL blocks for collecting a digital input signal.

The procedure is as follows:

1. Open the SITOP library.
2. Copy process tag type “SITOP” (1) to the “Process tag types” folder in the master data library.
3. Make sure that you copy the APL blocks that are used to the master data library too. To do this, create a CFC plan (2) into which you copy blocks “Pcs7DiIn” and “MonDiL” from the PCS 7 APL.
4. Apart from this, you need APL blocks “OpDi01”, “TimerP”, and “Pcs7DiOu” for the reset signal. Paste these blocks into the additional CFC plan (2) too.
6.3 Creating an AS program

The procedure is as follows:

1. Drag and drop process tag type “SITOP” to the desired folder in the technological hierarchy and rename it (1).

Fig. 6-4

2. Open the plan and adapt the input signal as follows:
   - Rename the monitoring block to match its use (2).
   - Interconnect input “PV_In” with the corresponding symbol of the external peripherals (3).
   - At the “Color” input (4) of the monitoring block, parameterize the value “16#1”. This is so that the system displays the value in red in the faceplate in accordance with an alarm.

Fig. 6-5
3. For a remote reset from the Operator Station, you must add to the program a
digital output driver block and an operation block for digital signals.
   - Paste APL blocks “OpDi01” (1), “TimerP” (2), and “Pcs7DiOu” (3) into the
     CFC plan.
   - Connect output “PV_Out” (4) to the corresponding symbol of the external
     peripherals.
   - Interconnect the blocks as shown in the figure. The timer block is
     configured as an extended pulse (mode = 1) and it ensures that the reset
     signal is connected for exactly one second. Interconnecting the timer block
     with the operation block (5) ensures that operators on the OS do not need
     to reset the signal manually.

4. Compile the AS program and update the view of the CFC plan.
5. Load the program into the automation system.
6.4 Parameterizing a message

To ensure that operators realize that a 24 V feeder has failed, the message of the monitoring block is also adapted.

The procedure is as follows:

1. Open the properties view of the “MonDiL” block and click on the “Messages...” pushbutton.
2. In the message configuration dialog, change the message text (1). However, leave the “$$BlockComment$$” system instruction in the message text.
3. Click on the “Save” pushbutton (2) to confirm your change.
4. Close the properties of the monitoring block.

Note: If you need message texts in several languages, you use the menu command Tools > Manage multilingual texts > Change language... in the SIMATIC Manager to change the language for display texts and adapt the text in the message configuration for the set language.
6.5 Creating a process picture

You need a process picture to visualize the status of the selectivity module.
The procedure is as follows:

1. Create a new process picture or open an existing one (1) in the folder of the technological hierarchy in which the CFC plan that you edited before is located.

Fig. 6-8

2. Execute the Compile OS function so that the system creates the process variables, the messages, and the block icon in the OS project.

3. Open the process picture using the WinCC Graphics Designer.

4. Draw the process picture as you want it to appear and position the block icons of signal monitoring (2) and the reset command (3) at the intended locations in the picture.

5. Save the adapted process picture and close it.

Fig. 6-9
6 Selective monitoring of 24V feeders

Note
In the example, an additional small square is configured as an LED lamp to represent the status of the assembly in color. With the square, the background color is dynamized and linked to the process values of the monitoring block.

- OUT#Value = 0 -> green
- OUT#Value = 1 -> red

6.6 Runtime

After starting runtime and switching to the corresponding technological hierarchy, it is now possible to monitor the status of the selectivity module on the OS. Apart from this, the system issues a message in the case of a fault.

Once you have eliminated the fault, you can reset the module using the operator block.

Fig. 6-10
7 Power supply system SITOP PSU8600

The PSU8600 basic module has four 24 V feeders that are switched off individually in the case of overloading. A CNX8600 expansion module is plugged in to the basic module to provide four more 24 V feeders with selective monitoring, as well as a BUF8600 buffer module. You can set the current response thresholds individually for each output. When you do this, you must take into account the maximum output power of the basic unit.

Fig. 7-1
7.1 Hardware configuration

You configure the AS and the external peripherals according to the PCS 7 standard. To configure the power supply system, the corresponding GSD must be installed. You can find the Generic Station Description in the item entitled GSD for SITOP PSU8600 for integration in Step 7 V5.

Parameterizing Ethernet nodes

The SITOP PSU8600 communicates by means of PROFINET IO on the automation system’s fieldbus. If you have not already done so, you must first adapt the IP address and the device name of the PSU to the network configuration of the fieldbus.

Note

To parameterize the Ethernet nodes, they must be on the same physical network as the ES. After this, you can make the separation between the plant bus and the process bus (field level).

The procedure is as follows:

1. Make sure that the device is on the same physical network as the configuration computer.
2. In the SIMATIC Manager, execute the menu command “Target system > Edit Ethernet Node”.
3. In the “Edit Ethernet Node” dialog, click on the "Browse" pushbutton (1) in the “Ethernet Node” area.
4. In the “Browse Network” dialog, choose the PSU8600 from the list of nodes and click on “OK” to confirm your selection.
5. Edit the IP address to match your network configuration and click on the “Assign IP Configuration” pushbutton (2).
6. Edit the device name and click on the “Assign Name” pushbutton (3).
7. Close the dialog again.
Integration of a SITOP 24 V Power Supply in PCS 7

Entry ID: 109481908, V1.0, 04/2016

Fig. 7-2

Edit Ethernet Node

- Ethernet node
  - MAC address: 78:9F:87:00:28:45

Nodes accessible online

- Set IP configuration
  - Use IP parameters
    - IP address: 192.168.72.11
    - Subnet mask: 255.255.255.0
  - Gateway
    - Do not use router
    - Use router

- Obtain IP address from a DHCP server
  - Identified by
    - Client ID
    - MAC address
    - Device name
  - Client ID: 

- Assign IP Configuration

Assign device name

- Device name: PSU0001
- Assign Name

- Reset to factory settings

Close

© Siemens AG 2016. All rights reserved
Configuring the hardware

The procedure is as follows:

1. Drag the PSU8600 from the device catalog (1) onto the PROFINET IO system of the AS.

2. Highlight the PROFINET IO device and drag one CNX8600 expansion module and one BUF8600 buffer module each (2) to a free slot on the basic module. A maximum of five slots per basic module are available.

3. Open the properties of the PSU and enter the device name (3) and the device’s IP address (4).

Fig. 7-3
Setting the SITOP PSU8600 parameters (commissioning)

In the HW configuration for the PSU8600, you can set general parameters, parameters for PROFIenergy and the output parameters of the basic module’s and the expansion module’s 24 V outputs.

You can find more detailed information on the different parameters in the SITOP PSU8600 manual.

The procedure is as follows:

1. Select the PSU8600 (1) in the hardware configuration.
2. Open the properties of the “PSU8600 3ph” module (2) on slot 0.1 by double-clicking.
3. Switch to the “Parameters” tab and set the parameters (3) as desired.
4. Open the properties of the 24 V outputs one after the other (4) and set the parameters of the outputs as desired.
5. Compile and load the hardware configuration.

Fig. 7-4
Note

Note that remote parameterization by means of the HW configuration is only effective if you have set the “REN” DIP switch (1) on the device to the “ON” position.

Configuring symbols

To interconnect the driver block of the control program with a symbolic address at a later time, parameterize the I/O addresses of the basic module using symbols.

The procedure is as follows:
1. Select the PSU8600 in the hardware configuration.
2. Highlight module “UPS1600 xxA PN” on slot 0.2 and execute menu command “Edit > Symbols…”.
3. Parameterize a symbolic name (1) on the first input word.
4. Compile and load the hardware configuration.

Fig. 7-5
7.2 Copying process tag types

The function blocks of the SITOP PSU8600 are configured in process tag type “PSU8600_CNX8600”. This type contains one “DrvPSU” driver block, the “PSU8600” monitoring block, and three “CNX8600” blocks of the expansion modules. The “PSU8600” process tag type does not contain any blocks of the expansion modules. The blocks have already been correctly interconnected with one another.

The procedure is as follows:

1. Open the SITOP library.
2. Copy process tag type “PSU8600_CNX8600” (1) to the “Process tag types” folder in the master data library.

Fig. 7-6
7.3 Creating an AS program

The procedure is as follows:

1. Drag process tag type “PSU8600_CNX8600” from the project library and drop it in the desired folder in the technological hierarchy and rename it (1).

2. Open the CFC plan and carry out the following modifications in the AS program:
   - Open the properties of the “PSU8600” block and rename it to match its use (2).
   - Parameterize a symbol variant (3). Four symbols are available: Choose the appropriate symbol, depending on the number of expansion modules that are connected to the PSU.
   - Interconnect input “AddrIn” (4) with the corresponding symbol of the PSU8600 from the hardware configuration.
   - Delete the “CNX86002” and “CNX86003” blocks of the expansion modules if you do not need them.
3. Compile the AS program and update the view of the CFC plan.
4. Load the program into the automation system.

7.4 Messages

The messages of the SITOP PSU8600 have already been parameterized in the function block and you do not need to change them.
7.5 Creating a process picture

You need a process picture to visualize the status of the selectivity module. The procedure is as follows:

1. Create a new process picture or open an existing one (1) in the folder of the technological hierarchy in which the CFC plan that you edited before is located.

Fig. 7-10

2. Execute the Compile OS function so that the system creates the process variables, the messages, and the block icon in the OS project.

3. Open the process picture using the WinCC Graphics Designer.

4. Draw the process picture as you want it to appear and position the block icon of the PSU8600 (2) at the intended location in the picture.

5. Save the adapted process picture and close it.

Fig. 7-11
7.6 Runtime

After starting runtime and switching to the corresponding technological hierarchy, it is now possible to monitor the status of the power supply system on the OS.

Fig. 7-12
Commissioning the demo project

You need the hardware to test the functionality of the SITOP UPS1600 and the PSU8600. Testing with PLCSIM is not possible. You can, however, load the AS program in PLCSIM and it is possible to set the signals of the redundancy and selectivity modules or display them.

Figure 8-1

8.1 Installation

Before opening the project, install the Generic Station Description (GSD) of the UPS1600 and of the PSU8600 on your engineering system. You can find the GSD and corresponding installation instructions in the following items:

- GSD for SITOP UPS1600 for integration in STEP 7 V5
- GSD for SITOP PSU8600 for integration in STEP 7 V5.5

Retrieving a project

If you have not already done so, download the project archive from the article page of this application example. Carry out the following steps:

1. Start SIMATIC Manager.
2. Execute the "File > De-archive..." menu command and choose the project archive that you downloaded.
3. Open the de-archived project.

Adapting the hardware configuration

The procedure is as follows:

- Adapt the computer name of the ES
- Adapt the network addresses (AS, ES, ET 200, UPS1600, PSU8600)
- Compiling and loading the hardware configuration
- Compiling and loading the connections in NETPro
- Compiling and loading the AS program
- Compiling and loading the OS project (if required)
If you do not have available a CPU 410-5H, then configure a new automation system. The procedure is as follows:
1. Create an AS according to your existing hardware.
2. Configure the external peripherals as shown in Chapters 4.1, 5.1.1, 5.2.1, 6.1 and 7.1.
3. Switch to the view of the technological hierarchy and change the AS assignment (1) of folders “PCS 7 Process”, “SITOP 24 V”, and “SITOP PSU8600” to the new automation system.

**Note** Changing the AS assignment in the technological hierarchy shifts the relevant CFC plans and blocks to the new AS.

Fig. 8-2
8.2 Operating SITOP modular

8.2.1 Overview of the power supply

After starting runtime, switch to the “SITOP 24 V” system area. In this process picture, the system gives you the information below or you can carry out these operations:

- Operating status of the power supply units (1)
- Failure of redundancy or falling short of the voltage threshold (2)
- Status of the UPS when connected to Industrial Ethernet (3)
- Status of the UPS when monitoring the signal contacts (4)
- Short-circuit or overloading of a 24 V-feeder (5)
- Reset of the selectivity module (6)
- Display and acknowledgment of the last message with the highest priority (7)

Figure 8-3
8.2.2 Monitoring of redundancy

In the sample project, another process picture is configured for monitoring redundancy. You can call the picture by switching to the “SITOP Redundancy” sub-area.

Figure 8-4

In the process picture, you will get the following information:
- Operating status of the power supply units (1)
- Failure of redundancy or falling short of the voltage threshold (2)

Figure 8-5

The block icons of the digital inputs for the redundancy module and the power supply units come from the PCS 7 Advanced Process Library and are not gone into in any further detail here.
8.2.3 Monitoring of the DC UPS

In the sample project, another process picture is configured for monitoring the uninterruptible power supply. You can call the picture by switching to the “SITOP Buffering” sub-area.

Figure 8-6

In the process picture, you will get the following information:
- Status of the UPS when connected to Industrial Ethernet (1)
- Status of the UPS when monitoring the signal contacts (2)

Figure 8-7

The block icons of the digital inputs for monitoring the signal contacts of the DC UPS come from the PCS 7 Advanced Process Library and are not gone into in any further detail here.
When monitoring via Industrial Ethernet/PROFINET, the uninterruptible power supply has its own block icon with faceplate. By installing the SITOP library, the necessary components are copied to your system. Below, we will give you a brief description displays on the Operator Station.

**Block icon**

You can see the following information in this symbol:
- Battery charge status
- Active message
- Saved note

![Figure 8-8](image)

**Faceplate**

The faceplate for the UPS1600 makes available the following views:
- Standard view
- Alarm view
- Trend view
- Note view
- Batch view (not described)
Standard view

In the standard view, you get detailed information about the operating status of the DC UPS.

Figure 8-9

![Standard view](image)

Alarm view

Message view displays the messages of the block. Here, you can acknowledge individual messages or all of them.

Figure 8-10

![Alarm view](image)
Trend view

In trend view, you can display all the important values as a curve progression. If value archiving is activated on the AS block, you can switch between current values and archive values.

Figure 8-11

Note view

In note view, you can store messages for other operating or maintenance personnel. The system displays an active message on the block icon.

Figure 8-12
**8.2.4 Monitoring the selectivity module**

In the sample project, another process picture is configured for monitoring selectivity. You can call the picture by switching to the “SITOP Selectivity” sub-area.

Figure 8-13

In the process picture, you will get the following information:
- Operating status of the 24 V-feeders (1)
- Reset of the module after eliminating the faults (2)

Figure 8-14

The block icons of the digital input and of the command block for the selectivity module come from the PCS 7 Advanced Process Library and are not gone into in any further detail here.
8 Commissioning the demo project

8.3 Operating the PSU8600 power supply system

After starting runtime, switch to the “SITOP PSU8600” system area. The block icon of the PSU8600 (1) is stored in this process picture.

When monitoring via Industrial Ethernet/PROFINET, the power supply system has its own block icon with faceplate. By installing the SITOP library, the necessary components are copied to your system. Below, we will give you a brief description displays on the Operator Station.

Block icon

The block icon shows the currents at the present time of the PSU8600’s four selective outputs. If there is a fault, the system displays a maintenance request (2) and changes the color of the output fields back to black.

Figure 8-15

Figure 8-16
Faceplate

The faceplate for the PSU8600 makes available the following views:

- Standard view
- Alarm view (corresponds to the APL standard)
- Trend view (corresponds to the APL standard)
- Note view (corresponds to the APL standard)
- Batch view (corresponds to the APL standard)
- View for expansion modules (1..3)
- View for buffer modules (1..2)

Standard view

In standard view, you can view the status of the power supply system or the operating status (3).

Figure 8-17

![PSU8600/PSU6600](image-url)
Expansion modules

Clicking on the “Further Views” pushbutton (4) takes you to the pushbuttons for displaying the expansion modules. The number of pushbuttons that are displayed depends on the hardware configuration.

You can monitor the status of the expansion modules here.

Figure 8-18

Buffer modules

Clicking on the “Further Views” pushbutton again takes you to the pushbuttons for displaying the buffer modules. The number of pushbuttons that are displayed depends on the hardware configuration.

You can monitor the status of the buffer modules here.

Figure 8-19
9 References

Table 9-1

<table>
<thead>
<tr>
<th>Topic</th>
</tr>
</thead>
<tbody>
<tr>
<td>\1\ Siemens Industry Online Support</td>
</tr>
<tr>
<td><a href="https://support.industry.siemens.com">https://support.industry.siemens.com</a></td>
</tr>
<tr>
<td>\2\ This article</td>
</tr>
<tr>
<td><a href="https://support.industry.siemens.com/cs/ww/view/109481908">https://support.industry.siemens.com/cs/ww/view/109481908</a></td>
</tr>
<tr>
<td>\3\ General information about SITOP power supply</td>
</tr>
<tr>
<td><a href="http://w3.siemens.com/mcms/power-supply-sitop/en/Pages/24vdc-power-">http://w3.siemens.com/mcms/power-supply-sitop/en/Pages/24vdc-power-</a></td>
</tr>
<tr>
<td>supply.aspx</td>
</tr>
<tr>
<td>\4\ SITOP library for PCS 7 V8.0 and V8.1</td>
</tr>
<tr>
<td><a href="https://support.industry.siemens.com/cs/ww/view/109476154">https://support.industry.siemens.com/cs/ww/view/109476154</a></td>
</tr>
<tr>
<td>\5\ Generic Station Description (GSD) for SITOP UPS1600</td>
</tr>
<tr>
<td><a href="https://support.industry.siemens.com/cs/ww/view/75854605">https://support.industry.siemens.com/cs/ww/view/75854605</a></td>
</tr>
<tr>
<td>\6\ SITOP UPS1600/UPS1100 manual</td>
</tr>
<tr>
<td><a href="https://support.industry.siemens.com/cs/ww/view/84977415">https://support.industry.siemens.com/cs/ww/view/84977415</a></td>
</tr>
<tr>
<td>\7\ SITOP PSU8200 1PH manual</td>
</tr>
<tr>
<td><a href="https://support.industry.siemens.com/cs/ww/view/92575279">https://support.industry.siemens.com/cs/ww/view/92575279</a></td>
</tr>
<tr>
<td>\8\ SITOP PSE202U redundancy module manual</td>
</tr>
<tr>
<td><a href="https://support.industry.siemens.com/cs/ww/view/42248598">https://support.industry.siemens.com/cs/ww/view/42248598</a></td>
</tr>
<tr>
<td>\9\ SITOP PSE200U selectivity module manual</td>
</tr>
<tr>
<td><a href="https://support.industry.siemens.com/cs/ww/view/61777451">https://support.industry.siemens.com/cs/ww/view/61777451</a></td>
</tr>
<tr>
<td>\10\ SITOP PSU8600 power supply system manual</td>
</tr>
<tr>
<td><a href="https://support.industry.siemens.com/cs/ww/view/105867947">https://support.industry.siemens.com/cs/ww/view/105867947</a></td>
</tr>
<tr>
<td>\11\ Generic Station Description (GSD) for SITOP PSU8600</td>
</tr>
<tr>
<td><a href="https://support.industry.siemens.com/cs/ww/view/102254061">https://support.industry.siemens.com/cs/ww/view/102254061</a></td>
</tr>
<tr>
<td>\12\ Function blocks for monitoring the selectivity module using</td>
</tr>
<tr>
<td>single-channel signaling</td>
</tr>
<tr>
<td><a href="https://support.industry.siemens.com/cs/ww/view/61450284">https://support.industry.siemens.com/cs/ww/view/61450284</a></td>
</tr>
<tr>
<td>\13\ SIMATIC PCS 7 standard architectures (V8.1 SP1)</td>
</tr>
<tr>
<td><a href="https://support.industry.siemens.com/cs/ww/view/109480315">https://support.industry.siemens.com/cs/ww/view/109480315</a></td>
</tr>
<tr>
<td>\14\ SIMATIC PCS 7 with PROFINET</td>
</tr>
<tr>
<td><a href="https://support.industry.siemens.com/cs/ww/view/72887082">https://support.industry.siemens.com/cs/ww/view/72887082</a></td>
</tr>
<tr>
<td>\15\ SITOP Selection Tool</td>
</tr>
</tbody>
</table>

10 History

Table 10-1

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Change</th>
</tr>
</thead>
<tbody>
<tr>
<td>V1.0</td>
<td>04/2016</td>
<td>Published for first time</td>
</tr>
</tbody>
</table>